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Business equipment
Most organisations depend on business equipment to operate. The most common piece of 
equipment in the office is the computer, which is used to input, process and output business 
information.

You might also have to use printers, scanners and photocopiers. Descriptions of the 
functions of each of these types of business equipment are provided here.

Printers

A printer is a device that produces a paper copy of the information displayed on the monitor of 
your computer. There are many different printers available. The main differences are the speed 
at which material is printed, the quality of the print, the options available and the cost.
Your organisation may have several different printers and you will have to make a decision 
about which one is most appropriate for your use. For example, does your document need to 
be printed in colour, or black and white? Do you need to print on one side or both sides of the 
paper?
Printing usually involves a number of decisions. Before you press the ‘print’ button, you need to 
consider the specific requirements of your task, the software application you are using and the 
capabilities of your printer. You may have various options for printing. For example, in Microsoft 
Project you can choose to print a project overview, a summary of tasks or just the milestone 
tasks. If you are printing a spreadsheet, you may wish to print it at actual size, or scale it down 
to fit on one page. 

Scanners

A scanner is a device that produces a digital version of a hard-copy document. For example, 
if you scan the hard-copy version of a report into a computer, you can send the information 
electronically or make alterations before reprinting.
A scanner can be a useful piece of equipment if you are producing a newsletter, catalogue or 
any other document containing photographs, illustrations, maps or handwritten material. It 
can copy a selected image into a graphic file on a computer. This can then be imported into 
the document you are working on. The image can be re-sized, if you need to make it smaller, or 
cropped if you only want to keep part of the image.
There are two primary types of scanner:

•• a flat-bed scanner that is connected to your computer but stands alone
•• a scanner that is incorporated into a fax machine and/or photocopier.

A flat-bed scanner can scan most images as it caters for many different sizes, from a 
photograph to a map. The other type of scanner is not as flexible and is most suited to single-
sheet documents up to A4 size.

Photocopiers

Photocopying is a process that makes a paper copy of a document, or any other visual image, 
quickly and cheaply. If an organisation needs multiple copies of a document, a photocopier is 
the most suitable equipment to use. Documents such as price lists, product information and 
internal reports often need to be copied and sent to customers, or stored for employee use. 
Because people use photocopiers so frequently, it has prevented most offices from becoming 
totally paper free. Try to use the photocopier in your organisation wisely and save paper.
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The layout and style of a publication is critical to its impact on the reader, just as the 
contents are.

If a business document is difficult to read because of poor design features, its contents are 
less likely to make any impact on the reader of the document. The reader may be distracted 
by poor layout instead of concentrating on understanding the content.

Layout and styles
The layout and style of a publication will depend on what the organisational requirements 
are for the particular document type. Any document you create must fit the specifications 
of your organisation. It is a good idea to find a sample before you start. By looking at the 
sample and asking about the specifications, you should be able to work out exactly what 
layout is required.

For example, your organisation might have a preferred layout for business reports, which 
will require using the following guidelines for structure and format.

Structure

•• Begin with an outline.
•• Follow this with bullet points

covering the major issues.
•• End with a report summary.

Format

•• Use a particular font type and
size (such as Times New Roman
12 pt).

•• Use a certain colour and style
for headings (such as black and
bold).

•• Make sure paragraphs are
double-spaced so the report is
easy to read.

1B	 Select layout and style of publication



 © Aspire Training & Consulting 13

Topic 1
Select and prepare resources

Inputting information into the computer is just the beginning. Once you have entered 
the relevant data, you must organise the content and structure. This is called designing a 
document and each task will be different. It all depends on the type of document you are 
working on and the requirements of your workplace.

The document you are designing needs to be prepared using consistent design principles in 
line with organisational or client requirements. Consistent design ensures that the layout 
of the content flows smoothly and the final presentation is professional. Consistent design 
techniques should be used in the following features of your document.

Headings

Use a font and font size for a major heading so it will inform the reader of the focus of the 
page/document. Headings should be large enough for easy reading and can be centred, left 
aligned or right aligned. There is usually only one major heading but sometimes there is a 
major subheading also (which should be in a smaller font size).
Subheadings are a transition from the major heading to body text and make it easy for readers 
to locate information. Subheadings are usually in bold and in a smaller font size than the major 
heading/s. 

Lists

Numbered and bulleted lists can have less spacing between items and more above and below 
the list.

Borders and lines

Borders and lines can be added to documents. Again, spacing must be consistent – if you 
insert a 12 pt space (or one Enter) before one line, then the next line must have the same 
amount of spacing used.

Spacing

Variations can occur; for example, the spacing between a bulleted list could be reduced to 3 
pt or 4 pt if it is necessary to fit text on a page, or spacing after subheadings could be reduced. 

Punctuation and capitalisation

It is important that punctuation is consistent throughout, including such things as the use of 
single or double quotation marks, and whether items in a list are separated by a comma or 
not. Capitalisation in headings must be consistent; for example, in this unit only the first letter 
of headings are capitalised. This style of capitalisation is called minimal capitalisation. 

1C	 Ensure consistency of design with 
company and/or client requirements
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Example: report design
The following example shows the same report designed in two different ways.

Report on paper usage

Overview

Paper usage has reached an all-time high 
with twice as much paper being ordered 
per month as was ordered last year. This 
report outlines strategies to reduce paper 
wastage.
Main points

•• All printers purchased to have double-
sided printing capacity.

•• All printing to be tracked by the printer
and each department made aware of its
monthly paper usage.

•• Budget for paper consumption to be
reduced.

•• Staff to communicate using emails
rather than written memos.

Summary

It is hoped that these changes will bring 
about a 25 per cent reduction in paper 
usage. Up-to-date figures and costs for 
paper consumption will be released in one 
month.

Report on paper usage
Overview
Paper usage has reached an all-time high 
with twice as much paper being ordered 
per month as was ordered last year. This 
report outlines strategies to reduce paper 
wastage.
Main points
All printers purchased to have double-sided 
printing capacity.
All printing to be tracked by the printer 
and each department made aware of its 
monthly paper usage.
Budget for paper consumption to be 
reduced.
Staff to communicate using emails rather 
than written memos.
Summary
It is hoped that these changes will bring 
about a 25% per cent reduction in paper 
usage. Up-to-date figures and costs for 
paper consumption will be released in one 
month.
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Efficient entry of information helps to streamline the 
overall process of document preparation. If you have 
all of the information you need at hand prior to 
commencing, you can sort it into a logical sequence.

Set aside a realistic amount of time to prepare 
your document. If you rush or stop and start the 
preparation frequently, you are more likely to make 
mistakes and the document may not flow in a logical 
sequence.

In order to maximise the presentation of information 
you might consider applying or customising a 
particular theme for your document. This entails 
formatting an entire document with a theme to 
give it a professional and modern look. A document 
theme is a set of formatting choices that include a set of theme colours, fonts (including 
heading and body text fonts) and effects (including lines and fill effects).

Programs such as Microsoft Office Word, Excel and PowerPoint provide several predefined 
document themes, but you can also create your own by customising an existing document 
theme, and then by saving it as a custom document theme. Document themes are shared 
across Microsoft Office programs so that all of your documents can have the same, 
uniform look.

Enter information efficiently
There are two main components to entering information efficiently. The first is making 
sure you have everything you need at hand, so you don’t have to stop and search for more 
information. This is a way to maximise your efficiency as the author of the document. 
Sometimes you might even be able to copy information from another business document. 
If you were compiling a report on expenditure, for example, you might be able to copy key 
figures directly from the accounting package or records spreadsheet.

The second is ensuring that the information is presented in the most appropriate way, so 
that a reader of your document does not need to stop and think in order to understand it. 
This is a way to maximise the efficiency of the document for the reader.

Allow a realistic amount of time
It is essential that you allow a realistic amount of time to prepare your document.

Instead of making a plan for the best-case scenario, you should consider worst-case 
scenarios you can’t control; for example, the printer or photocopier breaks down, or 
someone else needs to use them at the same time.

If adequate time is not allowed, then:
• the document will not be prepared in time
• important information may be left out
• incorrect information will be included; for example, the sales figures for the wrong

quarter.

2B	 Design the document to maximise 
the presentation of information



30  © Aspire Training & Consulting

BSBITU306
Design and produce business documents

Customise the theme fonts
Theme fonts contain a heading font and a body text font. When you click the Theme Fonts 
button , you can see the name of the heading font and body text font that is used for each 
theme font below the Theme Fonts name. You can change both of these fonts to create your 
own set of theme fonts.

1. In Word or Excel: on the Design tab, in the Document Formatting group, select a font.

2. In PowerPoint: on the Design tab, in the Variants group, select Fonts, then Customize
Fonts.

3. In the Heading font and Body font boxes, select the fonts you want to use. The sample
is updated with the fonts that you select.

4. In the Name box, type an appropriate name for the new theme fonts.

5. Click Save.
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Organising the content and structure of your  
document is the first step. Once you have designed a 
document, it needs to be formatted. For most 
documents, you will use a word-processing 
application, such as Microsoft Word, for this task. 
Within this program there is a range of functions to 
help make your work more consistent. In this section 
you will look at the software functions for:
• formatting text
• formatting styles
• headers and footers
• formatting tables
• merging and comparing documents, and

tracking changes
• spellchecking and editing.

Format text
Formatting the text of a business document improves the overall appearance and 
presentation of the information. Although many software programs have formatting 
options, this topic will only describe the functions of Microsoft Word 2013.

Before going any further you need to find, or create, a Word document you can work on. 
Make sure it has at least eight paragraphs and is at least three pages long. It can be on 
any topic. It might even be an existing document from your workplace. You will use this 
document to complete some of the tasks. You will also be asked to work on it as you read 
through the topic.

If you do not have a document you can access, go to your local newspaper’s website and copy 
a section of a news story to work on.

2C	 Use a range of functions to 
design the document
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Change existing styles
Alternatively, you may want to change the existing style of your document. For example, to 
change the attributes of the Heading 1 style, select text that has the Heading 1 style applied. 
Have a try on your existing document using the following steps:

1. Format the selected text with the new attributes that you want.
For example, you might decide that you want to change the size for the Heading A style
from 16 pt to 14 pt.

2. On the Home tab, in the Styles group, right-click the style that you want to change; for
example, Normal.

3. Click Update to Match Selection. All text with the style that you changed will
automatically change to match the new style that you defined.

If you changed the styles in a document and the styles are not updating the way you 
expected, click the Styles dialogue box launcher, and then click the Style Inspector button 

 to find out whether text was manually formatted instead of formatted by using styles.

Headers and footers
Headers and footers are displayed at the top and 
bottom of each page in a document. They usually 
contain information about the document. This can 
include a single line of text, multiple lines of text, a 
table or graphics. Headers and footers commonly 
contain information such as the document’s file path 
(or code), date and page number.

Often, there is a workplace standard about the 
information that goes in headers and footers. 
This ensures that all readers are aware of certain 
information about the document, such as when it was 
written or where it is located on the server.

The header and footer information can be contained 
within one section of the document, or can run 
through the entire document.
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Resize columns and rows
Depending on the type of information you have entered into your table, you may need to 
resize columns and rows. There are two ways of resizing columns and rows. You can simply 
use your mouse to drag the table parts into the right size, or you can use the menu options.

You are now going to resize the columns and rows in your table. Follow these steps.

Using the mouse option Using the menu option

1. Move your mouse onto the right edge of a
column or the bottom of a row you want to
resize. Your cursor will change into a two-
headed arrow.

2. Click and drag the column or row to the
required width or height.

1. Select a column to resize.
2. Select the Layout tab under Table Tools.

Click on Properties.
3. Select the Column tab. Enter the column

width into the Preferred width box. You
may have to experiment with the correct
size by looking at how the width change
has altered your column.

4. Click on the Previous Column or Next
Column buttons to change the width of
adjacent columns.

5. Select a row and repeat these actions to
modify its size.

Example: resize columns and rows
When you have finished, your table might look like the following example, where the columns have 
been resized to suit the information and save space.

Title Author Price

War and peace Leo Tolstoy $35.00

A tale of two cities Charles Dickens $40.00

Pride and prejudice Jane Austen $25.00

Little women Louisa May Alcott $30.00
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Merge and compare documents, and track changes
Business documents are often written by a number 
of people. Multiple people can also be involved in the 
edit. Tracking changes, and merging and comparing 
documents are useful techniques to help with this 
process.

To complete the work in this part of the topic, you 
need two identical documents. Make two copies of 
the Word document you are currently working on, 
and call them Document 1 and Document 2.

The Track Changes function is very useful if you 
want to revise or edit a document. It allows a person 
to insert, delete or move text or graphics and change 
the formatting. Microsoft Word uses revision marks 
to show these changes. The changes can then be reviewed and accepted or rejected by 
someone else.

If you are going through this process in several copies of the same document (for example, 
there are several people involved in the edit), you can merge the different copies and capture 
all the tracked changes into one document when they have finished. This will give you one 
final document to edit at the end.

Track changes
You are now going to track the changes in your Word documents. 

Follow these steps:

1. Open Document 1.

2. On the Review tab, in the Tracking group, click the Track Changes icon. Click the
Track Changes icon to turn Track Changes on or off.

3. Make the changes that you want by inserting, deleting, moving or formatting text or
graphics. You can also add comments. Word will track these changes as you make them.
Save the changes and close the document.
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Practice task 7
1. This is your first chance to work on the Word document that you have found or created. Use

the following basic formatting functions to complete these tasks. You do not have to save the
changes in your document.

•• Select three different fonts and three different font sizes. Apply these to part of your
document.

•• Bold, italicise and underline some of the sentences in your document.
•• Use the numbering function to list some of the sentences in your document.
•• Add a border to one sentence in your document.
•• Highlight one sentence in your document and change the font colour of another.

2. Find the Page Number Format dialogue box. Format the page numbers of your document so that
they are in lowercase Roman numerals; for example, i, ii, iii.

3. Use the table you have just inserted in your document to complete the following tasks:
•• Select three cells in your table.
•• Select two rows in your table.
•• Select one column in your table.
•• Select the whole table.

4. Resize some rows and columns.
5. Merge some cells.
6. Format the content in the table.
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Summary

1. Organisations need to identify, open and generate files and records according to task
and organisational requirements.

2. Organisations need to create, update and store their files in suitable locations so that
they can be easily accessed and maintained.

3. A business document is formatted to improve the presentation and appearance of
information.

4. Before designing a document, you need to think about who you are communicating
with and what information, or message, you are trying to convey.

5. Designing and formatting a document is about organising the structure and style to
maximise the readability of the information.

6. A range of software functions can be used to design, format, edit, merge, check and
improve the presentation of a document.

7. Input devices allow you to put information into a computer. The mouse controls the
cursor on your computer. To use a keyboard with speed and accuracy, you need to be
confident and streamline your actions.
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Accuracy of numerical and statistical data

└└ Match your document with the original figures you were given. It is very easy to make
a mistake when entering a lot of numerical data into a document.

Edit and proofread tools and symbols
If you proofread using Word, you can use the 
Track Changes setting as discussed. Select 
the Review tab and Track Changes. Once you 
have activated this setting, your proofreading 
and editing changes will be highlighted. To 
permanently remove any changes, you must 
accept or reject them.

Editing and proofing symbols are used on hard 
copies of documents to indicate where changes 
should be made. They are similar to shorthand, 
as they are much quicker and take up less 
space on the page than writing instructions in 
longhand.

The Style manual for authors, editors and 
printers (John Wiley & Sons) is the standard 
text used by the Australian Government. It 
provides an extensive discussion of editing and 
proofreading symbols and their use, as well 
as other editing and formatting issues. Some 
organisations also have their own in-house style 
manuals or guidelines.

You should be familiar with both common and 
non-standard editing symbols so you can easily 
interpret the changes suggested by others.



 © Aspire Training & Consulting 71

Topic 3
Produce the document

Example: directory hierarchy
Consider this example of a directory hierarchy.

In this structure the server has three folders for three separate workgroups: Group A, Group B 
and Group C. Group C has three major folders: Procedures, Personnel and Projects. The Projects 
Folder has three folders: Project A, Project B and Project C. The Project C folder has two documents: 
ProjectC_timelines.docx and ProjectC_research1.docx. The file path for retrieving a document starts 
at the server and ends when the correct document is located. For example, to reach the ProjectC_
timelines.doc the file path is: C:\GroupC\Projects\ProjectC\ProjectC_timelines.docx.

Digital storage
Paper documents can become damaged, yellowed 
and brittle. In addition, unless you are very careful, 
important documents can easily be torn, misfiled 
or accidentally thrown away. Storing a great 
many documents can also be expensive and some 
organisations prefer to store information digitally.

Digital storage saves paper and space. If the 
documents form part of a database, it also allows 
you to find specific information quite quickly. This is 
much easier than searching through the hard copies 
of the files. Databases also provide management with 
powerful reporting tools. For example, statistical 
information can be gathered from a database to 
produce a detailed report.
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Once you have selected and prepared your resources, and then designed and produced your 
document, you will finalise it. This entails a final proofreading, making any modifications 
necessary, naming and storing the document, exiting the application correctly and finally 
printing and presenting the document.

These processes must take place in a logical sequence to avoid missing any errors, or losing 
or damaging any data, and to make sure you produce a professional document according to 
the requirements of your organisation.

In this topic you will learn how to:
4A	 Proofread the document prior to final output
4B	 Make modifications
4C	 Name and store the document and exit the application
4D	 Print and present the document
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Once the document has been proofread and errors or inconsistencies identified, the 
document will need to be modified (or edited) accordingly. The modifications you make will 
depend on what computer software you are using, what sort of business document it is and 
what kind of modification.

The way you make modifications to a business document will depend on the software you 
are using. Commercial accounting packages such as Quicken and Mind Your Own Business 
(MYOB) have their own customised way of editing. If you are unfamiliar with this part of 
the package consult the manual, the online help or a work colleague.

You have already learnt about the edit feature of tracking changes in Microsoft Office 2013, 
as well as making design and layout modifications to text and tables. Another common way 
of making modifications to an existing document is to scan it and then modify it.

Types of modifications

•• Spelling and grammar
•• Style
•• Layout
•• Theme
•• Graphics
•• Table layout
•• Table formatting
•• Headers and footers

Edit a scanned document
Scan your document according to the instructions 
for your scanner.

Before you continue, convert the file that the scanner 
created to TIFF, which means tagged image file 
format. You can use Paint or another program to 
convert the file. 

You now have a document that you can edit. Be sure 
to save the new file so you don’t lose your changes.

Be aware that scanning a document does not always 
give a perfect result. Watch for documents that use 
unusual typefaces (fonts), as well as for confusion 
between similar looking letters and numbers. 
The upper-case letter O and the numeral 0 can be 
confused, as can the number 1, lower-case l and even upper-case I.

4B	 Make modifications
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Make modifications in Microsoft Excel
Obviously there are many reasons to make modifications in all of the programs you 
may use.

This is a common modification made when using Microsoft Excel 2013. It is used to edit the 
contents of a cell. This can be done either directly in the cell or in the formula bar.

1. To place the contents of a cell in editing mode, click the cell that contains the data
that you want to edit, and then click anywhere in the formula bar. This positions the
insertion point in the cell or formula bar. To move the insertion point to the end of the
cell contents, click the cell and press F2.

2. To edit the cell contents, do any one of the following:
• To delete characters, click where you want to delete them and then press Backspace, or

select them and then press Delete.
• To insert characters, click where you want to insert them, and then type the new

characters.
• To replace specific characters, select them and then type the new characters.
• To turn on Overtype mode so that existing characters are replaced by new characters

while you type, press Insert.
• Overtype mode can be turned on or off only when you are in editing mode. When

Overtype mode is turned on, the character to the right of the insertion point is
highlighted in the formula bar, and it will be overwritten when you type.

• To start a new line of text at a specific point in a cell, click where you want to break the
line, and then press Alt+Enter.

3. To enter your changes, press Enter. Before you press Enter, you can cancel any changes
that you made by pressing Esc. After you press Enter, you can cancel any changes that
you made by clicking Undo  on the Quick Access Toolbar.

Change column width
A cell may display ##### when it contains data that has a number format and that is wider 
than the column width. To see all text, you must increase the width of the column.

How to change the column width:

1. Click the cell you want to change the column width for.

2. On the Home tab, in the Cells group, click Format.

3. Under Cell Size, do one of the following:
• To fit all text in the cell, click AutoFit Column Width.
• To specify a larger column width, click Column Width and then type the width that

you want in the Column width box.
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Backup data
There are various methods of backing up (storing) your document. These are outlined here.

DVD Write drive 

└└ Data is copied onto DVD.

USB drive 

└└ Also known as a flash drive. This is a plug-and-play portable storage
device that uses fast flash memory and is lightweight and portable. 
These are commonly used in place of a DVD. When a USB drive is 
plugged into a USB port, the computer’s operating system recognises 
the device as a removable drive and assigns it a drive letter. Some USB 
devices have password protection or other security features.

External hard drive 

└└ A portable storage device that can be attached to a computer through a
USB or FireWire connection, or wirelessly. External hard drives typically 
have high storage capacities and are often used to back up computers 
or serve as a network drive.

Cloud computing 

└└ The practice of using a network of remote servers hosted on the internet
to store, manage and process data, rather than a local server or a 
personal computer.
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Presentation of the document
The final presentation of your document will be determined by the type, size and style 
of your document and the requirements applicable to your organisation or client. No 
matter which form of final presentation is used, the most important thing is that it is clear, 
accurate, a consistent style and professionally presented. Following are some of the various 
ways that business documents can be presented.

Electronic

•• Electronic presentation using
PowerPoint or any program
using the display provided by a
data projector

•• Presentation using
transparencies and an overhead
projector

•• Electronic presentation via
email or website

Hard copy

•• Printed, collated and stapled
documents

•• Bound book presentations
•• Printed documents within a

display folder
•• Printed documents in a

presentation wallet displaying
information unique to the
organisation such as logo,
letterhead and organisation
details

•• Printed and laminated
documents

•• Printed reports in a ring binder
or clipboard.




